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Welcome 
 

Congratulations!! On the purchase of Akruti the easiest way to start working with Indian 

Languages on your personal computer. 

 

You can have fun working with your PC in your mother tongue. You can send e-mails, 

design your web pages, send greeting cards, prepare visiting cards, design your personal 

letter pad, write school and college notes, legal documents, agreements, letters, infact 

anything and everything that could be done with most windows based application. Akruti 

can be used by companies for in-house magazines, religious publications, social service 

organisations for creating any kind of Local Language contents. 

 

Akruti is easy to install, requiring about 150MB space on your Hard Disk. It comes with 

professional quality fonts that are used by DTP professionals. It has popular Keyboard 

Layouts to facilitate easy learning and typing. With this package one can do work on most of 

the Windows applications in Indian languages. 

 
Go Ahead & Have Fun with Akruti   

 
 
No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval 
system or translated to any language in any form by any means without the express written 
permission of  Cyberscape Multimedia Limited. 
 

COPYRIGHT 
Akruti Software is the intellectual property of Cyberscape Multimedia Limited. 

 

Please read the license agreement before installing the software. 

 

Akruti is a product of Cyberscape Multimedia Limited and is available with various options. 

The contents of the software will depend upon the purchased options and the specifications 

may vary from time to time. Kindly check at the time of purchase about the details of the 

options, if required. The product  covered in this manual is Akruti. 

 

MS-DOS, Windows, Windows 95, Windows 98, Windows NT, Windows 2000 & Windows XP 

are trademarks of Microsoft Corporation. ATM is trademark of Adobe Systems Inc. LaserJet 

is trademark of Hewlett - Packard Co. All the other mentioned products are the trademarks 

of their respective owners. 

AKRUTI & MICROSOFT WINDOWS 

 

Akruti provides Indian Language Interface to Microsoft Windows Operating System 

developed by Microsoft Corporation. 
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AKRUTI SOFTWARE LICENSE AGREEMENT 
 

Opening this package indicates your acceptance of the terms and conditions in this 

“License Agreement”. This software product is provided by Cyberscape Multimedia 

Limited, (Cyberscape) either directly or through its dealer network only upon the following 

terms and conditions. 

 

This is a legal agreement between Cyberscape and the Licensee. Cyberscape reserves the 

right to take suitable action in case of any violations 

 

DISCLAIMER 

 

1. Cyberscape makes no warranties or representations with respect to the contents or 

the performance of Akruti Software  or this manual. 

2. The user is recommended to check any specific requirements thoroughly before 

purchasing the software. 

3. Cyberscape is not responsible for the installation and solving any problems arising 

out of this software package. 

 

LICENSEE 

 

The Licensee assumes full responsibility for the selection, installation and use of the 
program. Cyberscape assumes no  responsibility for any direct/indirect damages ensuing 
from  the use of this program. 

Copies of the program can be made only for back up purpose. When such back-up copies 
can not be used for commercial purpose. 

License : This software is licensed to work in one PC only. Additional licenses are to be 

purchased separately. For users with multiple licenses, you need to get a separate license 

certificate indicating the number of licenses. 
Corporate License is available for large organisations with multiple PCs and multiple 
locations. Contact us for more details. 
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We convey our sincere thanks with the deepest gratitude to the following persons 

without whom this product would not have been possible. 

 

We thank the almighty for guiding us to develop this software. We also thank all the 

users of Akruti, all the employees of Cyberscape Multimedia Limited, the distributors & 

resellers of Akruti, all other developers of Indian Language software, our family members 

and all who have contributed to the product. 

 

We express our deepest gratitude to Rajbhasha departments of all Central and State 

Government Organisations and PSUs, who have provided us with valuable feedback to 
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About Akruti 
 
What is Akruti Software ? 
Akruti is a general purpose yet powerful software which enables one to type in any Indian 

language in most of application software on your computer with the same ease as English. 

So from now on you can use any language of your choice with any of your application 

program. It is easy to install and easier to use. It comes with popular Keyboard Layouts viz. 

English Phonetic, DoE Inscript 88, Typewriter etc. 

 

It can be used by practically everybody, who uses computers for the love and fun of using 

the computer in your mother tongue. You can use Akruti in all the applications under 

Windows. You can use it effectively in Offices, Public Sector Undertakings, Nationalised 

Banks, Co-operative Banks, Schools, Colleges, Training Institutes, Authors, Writers, 

Students, Executives, Businessmen, Social Service Organisations, Politicians, Trade 

Unions, and all others, who have a love for the language and a computer to use. 

Features – 

1) Easy to install and use by the user. 

2) Contains TrueType fonts. 

3) Professional Typefaces to do any kind of job. 

4) Variety of  Keyboard Layouts to meet the popular demand. 

5) No hardware protection only a simple registration process. 

6) Can be used to create Language contents for Web Pages. 

7) Can be used for sending e-mails in your language. 

8) Powerful utilities. 

9) API calls to develop Applications in Indian Languages. 

 

The support and the responsibility  

Cyberscape Multimedia Limited will be very happy to give our valuable customers every 

support they wish, related to the Akruti. But the package being so user friendly, we wish to 

make the user responsible for the procurement and the installation of the basic software 

needs. Cyberscape will, in no way be connected with the procurement & installation of the 

pre-requisites. To know about the software requirements, see the chapter under the heading 

“Pre-requisites”. Cyberscape also wishes to inform that problems that are not related to the 

basic functioning of Akruti  software will not be a part of the software support. Cyberscape 

will provide support to its registered users through e-mail or telephone. On-site support will 

be charged extra. 

 

 

Packing List  
The Akruti software package consists of the following – 

1. Akruti  Installation CD 

2. Akruti User manual. 

3. Keyboard Layout Sticker(s) for your convenience. 

4. Registration card. 
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Akruti Installation procedure for Windows 95/98/2000/NT/XP/Vista 

 
1. Start WINDOWS  

 

 
 

2. Choose RUN from START menu. 
 

 
 

3. In the Run dialog , click the Browse button to open the Browse dialog box. 
 
4. In the Browse dialog box, select the CD-Drive in which the Installation CD is kept. 
 



Akruti Manual                                                                                                                                                         5 

 
 

5) Choose SETUP.EXE  from the directory. 

6) You will be introduced to the startup screen. When the startup screen disappears, the 

following window is displayed. 

 

 
 

7. This window will be followed by the information window, where you will be asked to give 
your Name, Organisation Name and the CD Serial Number. This is written on your CD-
ROM. 

 
 

Please mention your CD serial Number here. 
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For special corporate customers, we provide pre created unique serial number for the 
entire organisation. In those cases, there is no need to type serial number  in the box 
mentioned . 
 
8. You can specify a directory name in which you wish to install Akruti  or simply press Next 

to install in the default directory c:\Akruti . 
 

 
 
 
 

9. This Dialog box will confirm the Hard Disk Space available and space needed by Akruti 
and report in case the available space is less than required you need to make some 
additional space. 

 
10. Check the box “Create Icon on the Desktop” if you want a shortcut to be on the 

Desktop. 
11. Then click on the next  button. After this actual installation begins. 

12. During this phase, the files necessary for Akruti software are copied into the specified 

directory. 
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13. This Dialog box shows you the progress of the installation. 

14. This is final stage of installation of Akruti. 

 

 

 

15. This will show when the installation is completed and  you can restart  windows if you 

desire so. It is recommended that  you  restart your windows. 

 

 

 

16. This will roboot the system automatically. Now you  can go to the Akruti  folder in the 
menu, and run any of  the programs associated with it. 
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How to Register your Akruti 
 

1. Start Akruti Engine by clicking the Akruti icon created on the desktop or from Start – 
Programs – Akruti - AkrutiVistaar. 

 

2. When you start the engine it shows Registration form and asks for Registration ID. 

3. CD-serial was given by you when you installed the software. 

4. Product ID, is generated by Akruti according to your PC. It will be different for each and 

every computer. 

5. Based on CD serial number and Product ID. We are generating Registration ID (this is 

also sixteen digit number, each four digit number separated by a hypen). 

6. You have to communicate the Product ID and CD serial number, customer details to us, 

this can be done by phone/fax or by e-mail. Web registry services will be started soon  to 

register the product. On receipt of this information we will provide the Registration ID. 

The given Registration ID will work only on that particular PC. For additional PCs, extra 

licenses will have to be purchased. 

7. You can start Akruti without registering also by clicking the "Register Later" button. Akruti 

will work for 15 days from the date of installation without registering. Akruti will work as a 

full version during this period, for the last 3 days it will display a message "Product in 

trial". Simply click OK and continue working. 

 

Note: If you change the system date backward or forward the trial period will be over. You have 
to reformat the system before reinstalling Akruti.  

                    - e-mail :mumbai@cyberscapeindia.com  
UNINSTALLING AKRUTI 
To uninstall the AKRUTI click  the Uninstall  Program from Akruti Program group. This will 

remoe all the fonts, programs and the files copied by the setup program. This will not remove 
any files created by the user lying in Akruti directory. 
 

WHEN YOU ARE IN TROUBLE 

Akruti is easy to install and normally user should not encounter any problem while installing 

and using the software. However some useful tips are given here. 

 

Problem related to installation - 
As far as the installation problems are concerned, either you may get an error saying that the 

CD is not readable or you may get an error during the installation procedure. In both the 

cases (and any other defect), kindly send the faulty CD to our office at MUMBAI for 

replacement. The replacement is free of charge if returned within 30 days from the date of 

purchase (please send the xerox copy of bill) and if the damage is due to manufacturing 

defects. The decision of the company is final. 
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USING AKRUTI 
 
To start the Akruti program, click on the Akruti icon on the desktop or from Programs > 
Akruti  Group or execute the program  \AKRUTI\AKRUTI60.EXE.   
 

 
 

Note: The program is not automatically loaded. You  have  to manually start this by clicking 

the icon. 
 
This will load the software. The Akruti Engine is the heart of the software. From here you will 
be controlling your computer's multilingual capabilities. As soon as the engine is loaded, you 
will be introduced with a splash screen. Click on the screen to enter the engine interface. 
 

 
 
The Akruti interface would be as shown above. all the menus will be explained later. 
 

To type in any language in Bilingual fonts do the following :-  
 

a. Start the Akruti Engine. 

b. To see the keyboard select from the first option “Akruti” and then click on  Display 

Keyboard (The selected keyboard will be displayed on the screen). 

c. Choose the language of your choice (Hindi) from the “Script” menu. 

d. Choose the layout of your choice from the “Layout” menu. 

e. Do not change the “Application” menu at this point of time.  

f. Select from the “Font”  Menu  “Akruti Bilingual” or "Akruti Vistaar" 

g. Start your application like MS Office, Pagemaker etc. 

h. Press SCROLL  LOCK key or click on the “RED” button when “OFF” is indicated it will 

change color to “GREEN” and “ON” will display. 

i. Choose a Font like AkrutDev_BYogini, AkrutiVistaarYogini, AkruitOfficeYogini or any 

other bilingual in the respective language from the font list of your application or details 

about the fonts see the chart elsewhere in the manual. 

j. Start typing as per the layout. 

 

To type in English, do the following :-  

a. Press the SCROLL LOCK key ( OFF ). 
b. Start typing in English. 
 

Note :  There is no need to close Engine program for typing in English. For typing again in 

language, repeat steps g to h above. 
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To type in any language in Regular fonts do the following:- 

a. Start the Akruti Engine. 

b. To see the keyboard select from the first option “Akruti” and then click on Display 

Keyboard (The selected keyboard will be displayed on the screen). 

c. Choose the language of your choice (Hindi) from the “Script” menu. 

d. Choose the layout of your choice from the “Layout” menu. 

e. Do not change the “Application” menu at this point of time. 

f. Select from the “Font”  Menu  “Akruti Regular” 

g. Start your application like MS Office, Pagemaker etc. 

h. Press SCROLL LOCK key or click on the “RED” button when “OFF” is indicated it will 

change color to “GREEN” and “ON” will display. 

i. Choose a Font like AkrutDevYogini or any other Regular in the respective language 

from the fonts list of your application. For details about the fonts see the chart elsewhere 

in the manual. 

j. Start typing as per the layout. 

 

To type in English, do the following :- 
 

a. Press the SCROLL LOCK key ( OFF ). 

b. Select the English font like Arial, Times New Roman. 

c. Start typing in English. 

Note :  There is no need to close Engine program for typing in English. For typing again in  
language, repeat steps f to h above. 
Akruti English Halant f key.      Nukta ]   key. 
Phonetic Layout  
DoE Inscript Layout Halant d key .    Nukta  ]  key. 
Typewriter Layout Halant | key       Nukta ‘  key 

or shift + \ key.                   the key to the left of 1.)  
1. Typing by using the Akruti English Phonetic method is very simple. Characters are typed 

the way it is spoken. For combining characters, type the first character followed by halant 
and then follow it by the second character. Example kra is typed as ka + halant + ra. 
Similarly shtra is typed as Sha + halant + Ta + Halant + ra. Halant is available on “f” key. 
Read the Typing Sequence section  for details. 

2. You may experience that some conjuncts do not appear as they should if you are using 
programs like CorelDraw 10, MS Excel, Ventura etc. Change the mode from Generic 
from the Application menu. Then change the application type depending on the software 
you are using as given in the “Application Menu” 

Generic   For most of the Windows applications like PageMaker, MS Word etc. 
MS-Wordpad WordPad, Power Point, Netscape and E5.0 
MS-Excel For Excel 
Lotus 1-2-3,  
Star Office For Lotus 1-2-3  
CorelDraw For CorelDraw  
Oracle D2K Oracle 
Paradox For Paradox 
Ventura  For Ventura Publisher 
Publisher 4.2 
Pagemaker  For PageMaker Text Editor 
Text Editor 

The following programs work with generic  mode or the respective mode is automatically 
selected MS-Office, SmartSuite, Word Perfect, Open Office, Start Office, Word Pad, IE, 
Netscape, Page Maker,Quark, CorelDraw, Photoshop, VB, VC, Paint, Ventura, OracleD2K, 
Paradox 
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Exploring Akruti 

An Overview 

This chapter gives you a detailed overview of how to extract the powers of Akruti. It helps to 
guide you through the menus, commands and useful shortcuts to enhance your working. 
You will be explained with some basic information, such as- 
 
 
1. Activating Akruti and moving from one application to an other. 

2. Using Akruti Tools to create and manipulate multilingual text and graphics. 

3. Working with text, including how and when to use Akruti Script. 

4. Changing the language selection, keyboard selection and fonts. 

5. Fixing up the problems in display, printing and basic functioning of the Akruti programs. 

 

In the following session we will elaborate each item as it appears on each menu. This 

chapter is written with the basic assumption that the user is new to the multilingual software. 

However experienced users may find the tips and shortcut techniques very useful for them. 

 

Experiment freely with the utilities and techniques presented in this chapter. Don’t 
worry about making mistakes. You can always refer to the respective topics again. 
Above all, have fun exploring Akruti. 
 

Akruti Engine 

 
 

This is the core program of Akruti. It gets loaded when the Akruti Engine icon is clicked. It 
can also be invoked later if desired so. 
 

 

  
 

 
When the Akruti Engine system hook gets loaded, a sign on message is displayed. This 
message is self explanatory and it is to guide the next move for the operator.  
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 The menu wise details of this application are as follows: 
 

Save as Defaults 
 

To save the current setting as default. The setting involves the language, keyboard layout, 
application and the toggle key selection. The selected script, layout, application, toggle key 
options will be saved for further use. You will get the same options when you start windows 
hereafter, or even after putting the computer off. Otherwise the changes in the settings will 
be lost when you exit the application. 

 

 

Display Keyboard  
 

This option will display the current selected keyboard Layout. 
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Auto Startup Setting 
With This option you can set the auto startup. This will start the Akruti Engine as soon as a 
window starts up. 

 

Look and Feel setting 
This option you can change the look of Akruti engine. You can change the colour and 
location of the engine 

 
 

Akruti in System Tray 
This option will hide the existing upside Akruti and it will be shown in the task bar. 
In the task bar mode you can change the setting by clicking the Icon. A and getting the 
required menus. You can restore by clicking on restore to desktop. 
 

Create Shortcut (Desktop) 
This will create a short cut item on the desktop to start Akruti. 
 

Script  

 
This menu is used to select the language you want to use. The currently selected language 
is indicated by a tick mark on to the left. 
Note : The language selected there will be applicable for all the Windows applications that 
are currently running in your system. 
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Layout 

 
Caution: Certain keyboard layouts will not be available for all the languages. An error 
message will be flashed if such a combination is selected. 

Application Menu 
 

 
Though all windows applications handle the system resources in a uniform way, the 
keyboard  character codes get interpreted differently by different programs. In this menu, 
options are provided to select the applications in which you are going to work on, manually 
or automatically. Selecting Auto (default) will work well most of the programs. In case of any 
problem in any of the future application releases, choose manual mode and select the 
application type. If that language and the layout is still not working in that application, contact 
your CML. 

Font Menu 
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In Akruti Engine, you not only type in Akruti fonts you can also type in other font choose the 
target fonts for which you want the keyboard to work. Choosing wrong option may result in 
wrong characters/garbage 
 
In some version of Akruti, there is an option for selecting the type of  by selecting Akruti 
Regular you can use AkrutiDevPriya series fonts and by selecting Akruti Vistaar you can use 
AkrutiOfficePriya series Bilingual fonts and by selecting Akruti Bilingual you can use 
AkrutiDev_BPriya Bilingual fonts developed by Akruti. In the font menu also provided other 
companies fonts. This is given only as a convenience to the user, if he is used to other fonts. 

Error Messages 

If you choose a wrong layout that is not available in a particular language then an error 
message will be displayed and the current settings will not change. 
 

Utilities Menu 

The utilities are available only in Akruti Vistaar, Akruti Publisher packages and above 
Contact to upgrade to the higher versions. 
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Dictionary 

This program is to see the meaning of English to Hindi and Hindi to English with this you can 
copy the meaning for realated word and copy in the MS-Word or Pagemaker. 
 

 

 
 

Transliteration 
 
This program is to translate the English word to Hindi. This is  used mainly for names and 
addresses. 
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Type Assist 

This utility provides a simple way to type English and get Hindi. You need not have Akruti 
Engine working. 
 
 

 
 

Typing method using Akruti Executive  Layout 
 

This layout is based on English spellings equivalent to Hindi characters. Do not delete half of 

a block or character or matra. Delete the full phonetic block and retype the whole block. This 

method remembers the characters typed before, within a phonetic block. To start afresh, 

type a space and then delete it. This clears the residue in the buffer. 
 
 

Character Key(s)  

to  be pressed 

Char- 

acter 

Key(s) to be 

pressed 

Char- 

acter 

Key(s) to be 

pressed 

¡ a ¨î ka Ç da 

¡ð A ®ð kha Ïð dha 

ý I ±ð ga Ðð na 

ýá I ³ð gha Ñð pa 

£ u ´ shift 8 / Nga Òî pha 

¤ U µð cha ×ð ba 

¥ HRI ¶ chha Øð bha 

¦ e ¸ð ja Ùð ma 

¦÷ AY »ð jha Úð ya 

¦ù E ½ð shift - / Nja Ü ra 

¡ð÷ o ¾ Ta âð la 

¡ðø AW ¿ Tha ãð va 

¡ðù OE À Da äð sha 

¡ü aM Á Dha æð Sha /shha  

¡û aMM Âð Na çð sa 

¡: a: Ãð ta è ha 

- - Æð tha êð kSha/shift 3 

¨«î Ka ±«ð Ga ëð tra 

°ð Kha ¸«ð Ja ìð jNja / shift 5 

Ò«î fa Áÿ DHa Àÿ Ra 
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ISCII Converter 

 

This dialog box used to convert ISCII  format  to Akruti. 

 
 

Akruti Smart Converter 
 
The Smart Font Converter converts text from other fonts like Isfoc, Unicode, Akshar, Aps 

etc. This converter convert  the .txt file and clipboard data. 
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Access  Database Sorting 
 

This Program is for sorting the MS-Access database or any other database details and say 
OK. The sorted data will be created as aksorted .mdb. For other database create ODBC 
connection by going through control Panel. Your database administrator will guide you on 
this detail. 

 

 

Keyclick 
This Program is to type Hindi Language text with a mouse. 
Select the keyclick option. Keep the cursor inside your application where the data is to be 
typed, Press Ctrl + Alt + K the keyboard will pop up. Now click on the keyboard to get the 
required character on the screen. 
 

 
You can get a display like keyboard with normal and shift layouts or the varnamala 
sequence where all the vowel, consonants and matras are displayed. 
 

Number to words 
This program  for converting the numbers to words Click on the number to word menu. Place the curser wherever 

you want type some numbers copy the text and and press Ctrl+Alt+N then say insert. 
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Date Display 
1. Switch on the engine and select the language. 

 

 

2. Select Date Time option from utilities menu from your document, Click Control + Alt + D. 
3. It shows the dialog box, from which you can  select date & time and say ok. 
 
Multiple Clipboard :- 
 
This utility allows user to have 99 clipboard short cuts text format. Select Multiple Clipboard 
option from Utilities menu. 
1) Open a document. 
2) Select the text which you want to store on a clipboard press Control + Shift + 11 (This 

will store the selected  text to page 11 region.) 
3) Whenever You want to use clipboard text press   

Alt +Shift + 11  your storted text will paste. 
You can check with Clipboard  Viewer. 

 

Font Sampler 
This is used to see  sample of fonts available in your computer. 
 

Integrated Utilities for MS-Word. 
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Spelling Checker  
 

 

 
With Akruti, you get integrated spelling checker that you can invoke from a AkrutiXP.  
 

Akruti Hindi Sorting 
 
This will sort the hindi text in alphabetic order. Enter the text in tabular format and select the 
column and click on the AkrutiXplus Menu and say Akruti Hindi sort This will ask you the 
column and the order ascending or descending order then say OK this will the sort entire 
column. 
 

Smart Font Converter 
 
The Smart Font Converter converts text from other fonts like Isfoc, Unicode, Akshar, Aps 
etc. This utility can convert text in any font format to any other font format. Your page layout 
remains intact.  
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Dictionary and Translation 

This program is to see the meaning of English to Hindi and Hindi to English with this you can copy the meaning 

for realated word and copy in the MS-Word or Pagemaker. 

 

Number To Word 
 
This program  for converting the number to word you type some number and  select the 
number and click on the Akruti Xplus Menu and click on the number to word menu and say 
insert . 

 

Find and Replace 
With this option you can find and replace text in language. 
 

Open Unicode Document 
This will the open the document if any other versions of Akruti Vistaar. 
 

Save in Unicode 
This will save the file if the file is any other versions of Akruti Vistaar font. 
 

Save as HTML with Dynamic Fonts 
This Option will save the HTML with Dynamic Fonts for the Website needs. 
 

Copy text to other applications.. 
You can copy the text and pest it any other application. 
 

Save with Embedded font 
This will save the document with embedded font. 
 

Send Document through e-mail 
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This option will send the document with embedded font. 
 

Fax this document 
You can send the document to the fax. 
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Typing Sequence 
 
The Hindi or language typing can be done by using the same English keyboard and using 

the similar sounding alphabet in English. The example will be k for ˆÅ, t for ÷¸, r for £ etc. 

Certain characters like ’, “, ”, �, Œ, ‘¸, ©¸, «¸,  ¼ , Ÿ¸¸°¸¸, ƒ, ƒÄ, „, …, ‡, ‡½, ‚¸½, ‚¸¾,  Á,  ¸Á,  ¿,   Â,  –, ¶ 

require you to type some other keys as mentioned below. The combining of characters is 

achieved by using the halant key which is on the key `f'. For example kra (ÇÅ) is formed by ` 

ka+halant+ra' (ˆÅ +  Ã  + £) or (kfr). Similarly `da_dha' (Ö) in siddhi is formed by 

`da+halant+dha' (™ +  Ã  + š¸) or (dfD). Similarly the short `ee matra' is typed after he 

character. þÆ÷¸ is typed as `ka+halant+ta+ee_matra' (kfti). The reph character is formed as 

typing it as ra+halant+character. The word œ »̧µ¸ Ä̧ is typed as (pUrfNa). Devnagri can be 

activated by pressing SCROLL LOCK key. This is a toggle key for between English 

& Devnagari. The following table describes the key sequences to be :-  

 

™½̈ ¸›¸¸Š¸£ú �¸¸½”¸®¸£ �¸›¸¸›¸½ ½̂Å ¹¥¸‡ ˆÅú-�¸ ½̧”Ä �¸¸’Ä 

(Typing Sequence for Bilingual fonts) 

­¥¸¿·¸  ( d ) =  d  (lower)  for Phonetic 88 Key Board Layout 

­¥¸¿·¸  ( d ) =  f  (lower)  for English Phonetic Key Board Layout 

­¥¸¿·¸  ( d ) = d (Back Slash)  for Typewriter Key Board Layout 

 

Type This 

Character 

Get This 

Result 

Type This 

Character 

Get This 

Result 

‚   =  ‚ 

‚  +  ¸ =  ‚¸ 

ƒ   =  ƒ 

ƒÄ   =  ƒÄ 

„   =  „ 

…   =  … 

†   =  † 

‡   =  ‡ 

‡½   =  ‡½ 

‚  +  ½̧  =  ‚ ½̧ 

‚  +  ¾̧ =  ‚ ¾̧ 

‚  +       ¿=  ‚¿ 

‚  + : =  ‚: 

‚  +  Á =  ‚Á 

‚  +  Á̧ =  ‚ Á̧ 

‡  +   Á =  ‡Á 

£  +  º =  ² 

£  +  » =  ³ 

Â  +  › º̧Æ·¸¸ = – 

 ,        +  ,       = — 

—  + › º̧Æ·¸¸ = ¶ 

.  + › º̧Æ·¸¸ = . 

1 + › º̧Æ·¸¸ = ! 

ˆÅ +   Â = ˆÂÅ 

ˆÅ  +   Á̧ = ˆÅ Á̧ 

ˆÅ +    Ã +   ˆÅ       = ÆˆÅ 

 Ã  is indicated as ­¥ ¿̧·¸  

ˆÅ  +  ­¥ ¿̧·¸  +  £  =  Ç 

£  +  ­¥ ¿̧·¸  +  ̂ Å  =  ˆÄÅ 

‹¸  +  ­¥ ¿̧·¸  +  ›¸  =  ‹›¸ 

Œ  +  ­¥ ¿̧·¸  +  ̂ Å  =  ŒÃ̂  

Œ  +  ­¥ ¿̧·¸  +  ‰¸  =  ŒÃ‰¸ 

Œ  +  ­¥ ¿̧·¸  +  Š¸  =   ŒÃŠ¸ 

Œ  +  ­¥ ¿̧·¸  +  ‹¸  =   ŒÃ‹¸ 

•¸  +   ­¥ ¿̧·¸  +  ¡¸  =   •¡¸ 

Ž  +   ­¥ ¿̧·¸  +  £  =  Žï 

‘¸  +  ­¥ ¿̧·¸  +  •¸  =  ‘�¸ 

‘¸  +  ­¥ ¿̧·¸  +  •¸  =  ‘�¸ 

’  +   ­¥¸¿·¸   +  ’         =  Ø 

’  + ­¥ ¿̧·¸  + ’     = ’Ã’ 

’  +  ­¥ ¿̧·¸ + “  = Ù 

“  +  ­¥ ¿̧·¸  +  “  =  Ú 

”  +  ­¥ ¿̧·¸  +  •  =  Ü 

•  +   ­¥ ¿̧·¸  +  •  =  •Ã• 

µ¸  +  ­¥ ¿̧·¸  +  Ÿ¸  =  µŸ¸ 

·¸  +  ­¥ ¿̧·¸  +  ·¸  = î¸ 
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2 +  › º̧Æ·¸¸ = ` 

3  + › º̧Æ·¸¸ = ' 

4  +  › º̧Æ·¸¸ = ? 

5  +  › º̧Æ·¸¸ = / 

6  +  › º̧Æ·¸¸ = ;  

7  +  › º̧Æ·¸¸ = : 

8  +  › º̧Æ·¸¸ = ª¸ 

9 +  › º̧Æ·¸¸ = ¦ 

0 +  › º̧Æ·¸¸ = å 

ˆÅ  +  ›¸ºÆ·¸¸  = ˆöÅÅ 

Š¸  +  › º̧Æ·¸¸     = $¸ 

�¸  +  ›¸ºÆ·¸¸     = {¸ 

” +  ›¸ºÆ·¸¸       = ”õ 

�  +  › º̧Æ·¸¸     = •õ 

ûÅ  +  › º̧Æ·¸¸     = ûöÅ 

ˆÅ  +  ¸ = ˆÅ¸ 

ˆÅ  + ¹      = ¹ˆÅ 

ˆÅ  +  ú = ˆÅú 

ˆÅ +   º = ˆºÅ 

ˆÅ +  » = ˆ»Å 

ˆÅ  +   º = ˆºÅ 

ˆÅ  +   ½ = ˆÅ½ 

ˆÅ  +   ¾ = ˆ¾Å 

ˆÅ  +  ½̧ = ˆÅ ½̧ 

ˆÅ  +   ¾̧ = ˆÅ ½̧ 

ˆÅ  +  ¿   = ˆÅ ½̧ 

ˆÅ  +   : = ˆÅ: 

 

ˆÅ  +   Á = ˆÅÁ 

·¸  +  ­¥ ¿̧·¸  +  £ = °¸ 

™  +   ¼   = ´ 

™  +  ­¥ ¿̧·¸ + Š¸  = Ò 

™  +  ­¥ ¿̧·¸  +  ™  = Ó 

™  +  ­¥ ¿̧·¸  +  š¸  =  Ö 

™  +  ­¥ ¿̧·¸  +  £  = Í 

™  +  ­¥ ¿̧·¸  +  ¡¸  =  Ô¸ 

™  +  ­¥ ¿̧·¸  +  ̈ ¸  =  × 

™  +  ­¥ ¿̧·¸  +  •¸  =  Ñ 

™  +  ­¥ ¿̧·¸  +  ž¸  =  Õ 

›¸  +    ­¥ ¿̧·¸  +  ›¸  =  ››¸ 

œ¸  +  ­¥ ¿̧·¸  +  £ =  œÏ 

£  +  ­¥ ¿̧·¸  +  ·¸  = · Ä̧ 

¥¸ +  ­¥ ¿̧·¸  +  ¥¸  =  ¥¥¸ 

©¸ +  ­¥ ¿̧·¸  +  ›¸ =  ©›¸ 

©¸ +  ­¥ ¿̧·¸  +  •¸  =  ä¸ 

©¸ +  ­¥ ¿̧·¸  +  ̈ ¸  =  æ¸ 

0  +  › º̧Æ·¸¸  +  ¥¸  =  å¥¸ 

©¸ +  BS +  ¨¸   =  ©¨¸ 

©¸ +  ­¥ ¿̧·¸  +  £  =  ý 

«¸ +  ­¥ ¿̧·¸  +  µ¸  =  «µ¸ 

­ +  ­¥ ¿̧·¸  +  ¡¸  = à¸ 

­ +  ­¥ ¿̧·¸  +  £  = ã 

­ +   ¼    =  á 

­  +  ­¥ ¿̧·¸   +  Ÿ¸  =   ¯¸ 

­  +  ­¥ ¿̧·¸  +  ›¸  =  â 

­  +  ­¥ ¿̧·¸  +  ¥¸  =   ß 

­  +  ­¥ ¿̧·¸  +  ̈ ¸  =   Þ 

­  +  ­¥ ¿̧·¸  +  µ¸  =  íµ¸ 

osJeveeiejer pees[e#ej yeveeves kesÀ efueS keÀer-yees[& ®eeì& 

(Typing Sequence for Regular fonts) 

nueble  ( d ) =  d  (lower)  for Phonetic 88 Key Board Layout 

nueble  ( d ) =  f  (lower)  for English Phonetic Key Board Layout 

nueble  ( d ) = d (Back Slash)  for Typewriter Key Board Layout 

 

Type This 

Character 

Get This 

Result 

Type This 

Character 

Get This 

Result 

De   = De 

De  +  e = Dee 

F   = F 

F&   = F& 

G   = G 

T   = T 

$eÝ   = $eÝ 

S   = S 

keÀ +   B = keBÀ 

keÀ  +   e@ = keÀe@ 

keÀ +    d +   keÀ       = keÌkeÀ 

 d  is indicated as nueble  

keÀ  +  nueble  +  j  =  ¬eÀ 

j  +  nueble  +  keÀ  =  ke&À 

Ie  +  nueble  +  ve  =  Ive 

*  +  nueble  +  keÀ  =  ¹ 
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Ss   = Ss 

De  +  es  = Dees 

De  +  ew = Deew 

De  +       b=  Deb 

De  + : =   De: 

De  +  @ =  De@ 

De  +  e@ =  Dee@ 

S  +   @ =  S@ 

j  +  g = © 

j  +  t = ª 

B  +  vegkeÌlee = ß 

 ,        +  ,               = ~ 

~  + vegkeÌlee          = ç 

.  + vegkeÌlee          = ¤ 

1 + vegkeÌlee          = ! 

2 +  vegkeÌlee = ̀  

3  + vegkeÌlee          =    ' 

4  +  vegkeÌlee = ? 

5  +  vegkeÌlee = / 

6  +  vegkeÌlee = ;  

7  +  vegkeÌlee = : 

8  +  vegkeÌlee = µe 

9 +  vegkeÌlee = } 

0 +  vegkeÌlee = Í 

vegkeÌlee  + keÀ = ]keÀ 

vegkeÌlee  + ie = ]ie 

vegkeÌlee  + pe = ]pe 

vegkeÌlee  + [ = æ[ 

vegkeÌlee  + { = æ{ 

vegkeÌlee  + HeÀ = ]HeÀ 

keÀ  +  e = keÀe 

keÀ  + ef      = efkeÀ 

keÀ  +  er = keÀer 

keÀ +   g = kegÀ 

keÀ +  t = ketÀ 

keÀ  +   g = kegÀ 

keÀ  +   s = keÀs 

keÀ  +   w = kewÀ 

keÀ  +  es = keÀes 

keÀ  +   ew = keÀew 

keÀ  +  b   = keÀes 

keÀ  +   ë = keÀë 

keÀ  +   @ = keÀ@ 

 

*  +  nueble  +  Ke  =  ± 

*  +  nueble  +  ie  =  ² 

*  +  nueble  +  Ie  =  « 

®e  +  nueble  +  ³e  =  ®³e 

í  +  nueble  +  j  =  í^ 

_e  +  nueble  +  ®e  =  áe 

_e  +  nueble  +  pe  =  ¡e 

ì  +       nueble  + ì                  = Æ 

ì  +       nueble + þ                    = ù 

þ  +  nueble  +  þ  =  Ç 

[  +  nueble  +  {  =  ú 

{  +  nueble  +  {  =  ¶ 

Ce  +  nueble  +  ce  =  Cce 

le  +  nueble  +  le  = Êe 

le  +  nueble  +  j = $e 

o   +   =   = ¢ 

o  +  nueble + ie              = Ã 

o  +  nueble  +  o  =  Î 

o  +  nueble  +  Oe  =  × 

o  +  nueble  +  j  = ê 

o  +  nueble  +  ³e  =  Ðe 

o  +  nueble  +  Je  =  Ü 

o  +  nueble  +  ye  =  Â 

o  +  nueble  +  Ye  =  Ó 

ve  +  nueble  +  ve  =  vve 

He  +  nueble  +  j =  Òe 

j  +  nueble  +  le  =  le& 

ue +  nueble  +  ue  =  uue 

Me  +  nueble  +  ve =  Mve 

Me  +  nueble  +  ®e  =  ½e 

Me  +  nueble  +  Je  =  ée 

0  +  vegkeÌlee  +  ue  =  Íue 

Me  + BS +  Je  =  MJe 

Me  +  nueble  +  j  =  Þe 

<e  +  nueble  +  Ce  =  <Ce 

Shift  + ³e    =  îe 

n  +  nueble  +  ³e  = ¿e 

n  +  nueble  +  j  = Û 

n  +   =    =  Ë 

n  +  nueble  +  ce  =   ïe 

n  +  nueble  +  ve  =   Ú 

n  +  nueble  +  ue  =   ¼ 

n  +  nueble  +  Je  =   » 

n  +  nueble  +  Ce  =  ÔCe 



Akruti Manual                                                                                                                                                         27 

 

Font Compatibility with various Applications 
Indian Languages differ a lot from English and many programs have most of the default 
options set as per English. 
In such cases, working with Indian Languages, may pose some problems. The programs are 
MS Office, Lotus Smartsuite, Corel Draw, Pagemaker etc. Certain options are to be disabled 
in the programs to  make the software work properly. 
 
The symptoms in such cases are typically 
a) Characters getting replaced by another. 
b) Characters getting replaced by another after pressing space or enter. 
c) Some characters like quote marks do not appear at  all. 
It appears all right on screen, but prints a different character  on the printouts. 

All these problems are sorted out by selecting or removing certain options hidden inside 
various menus. The settings to be changed  are shown in the following pages. 
Some important guidelines in using Indian languages are 
 
a) Preserving upper and lower case 
b) No capitalising first character 
c) Not capitalising sentences 

Settings for Microsoft Word 

 
 

1. Go to Tools menu, and select the AutoCorrect option. 
2. Remove the tick marks from the following options  

 

 
 *  Correct TWo INitial, CApitals. 
 *  Capitalize first letter of sentences. 
 *  Capitalize names of days. 
 *  Correct accidental usage of cAPS LOCK key. 
 *   Replace text as you type. 
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Settings for Microsoft Word 
3. Click the tab - Autoformat as you type and remove the tick marks from the following 
options – 
 

 

 

 

 *   "Straight quotes" with "smart quotes" . 

 *   Ordinals (1st) with super script. 

 *   Fractions (1/2) with fraction characters (1/2). 

 *   Symbol characters (--)with symbols (--). 

 *   *Bold*and_underline_withreal  formatting. 

*   Internet and network paths with hyperlinks. 

 

4.  Click the tab –  

AutoFormat 

5.  In AutoFormat Munu Remove the tickmarks 

from the following options – 

 

 

 

 *  "Straight quotes" with "smart quotes"  

 *  Ordinals (1st) with super script 

 *  Fractions (1/2) with fraction character (1/2) 

 *  Symbol characters (--) with symbols (--) 

 *  *Bold*and_underline_with real formatting 

 *  Internet and network paths with hyperlinks 

 

      * Press OK. 
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6.  Go to Tools menu, and select the Options....    

 
 

7. Remove the tickmarks from the following options – 

 
 *   Check grammer as you type 
 *   Check grammar as you type 

        * Press Ok 

8. Go to Format menu, and select Font option: 

9. Remove the tickmarks from the following options  

 
*  Small caps 
*     Press Ok 
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Settings for Microsoft Excel 

1. Select all the cells you would be using for data entry in indian languages. 

2. Select the required Akruti font from the font list menu. 

3. Set the required font size. 

By doing this procedure, you can avoid repetitive work of setting the font and its size. 

 

 
 

4 .  Go to Tools menu, and select AutoCorrect option.  

 
 

5. Remove the tickmarks from the following options – 
 

 



Akruti Manual                                                                                                                                                         31 

 

*  Correct TWo INitial, CApitals 

*  Capitalize first letter of sentences 

*  Capitalize names of days 

*  Correct accidental usage of cAPLOCK key 

*  Replace text as you type 

6. Go to Tools menu, and select Option options. 
 

 
 

7. Remove the tickmarks from the following options.   

 
 

 *    Enable AutoComplete for cell values. 
 

8. Press the General Tab 

 

 
 

*  Change - Standard font - Akruti font. Press Ok. 
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Settings for Microsoft PowerPoint 

1. Go to Tools menu, and select AutoCorrect option - 
 

 

2. Remove the tickmarks from the following options – 

 
 

*  Correct TWo INitial,CApitals 

*  Capitalize first letter of sentences 

*  Capitalize names of days 

*  Correct accidental usage of CAPS LOCK key 

*  Replace text as you type 

 

Settings for Office 2000/XP/2003 
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When using language fonts in any of the applications of Office 2000 like Word, Excel, 
Powerpoint, Access, Front Page and Outlook Express, the font list menu of these 
applications looks like the figure given above.  

 

Settings for Office 2000/XP/2003 

 

1. From the Tools menu, select Customize option. 

2. Select the Options tab in the customize window. 

 

 
 
3.   Remove the tick mark from the option –   

*    List font names in their font 

 

4.  Say Close . 

 

 
 
 
 
Now the Font list menu will be legible as shown above. 
 
Note : This  setting is common to all the applications of Office 2000/XP/2003 
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Settings for Adobe PageMaker 

1. Go to File menu, and select the Preferences > General option. 
 

 
2. In the Preferences dialog box, click on the more button. 
 

 
 

Remove the tick mark from the option: 
 
* Use typographer's quotes - press OK. 

 

Settings for Adobe PageMaker 

 

 
1. Go to Type menu, and select the Paragraph option. 

2. In the Paragraph dialog box, click the Spacing button. 

 

 

3. In the Spacing Attributes dialog box, set the Letter space 
    parameters Minimum, Desired and Maximum to zero. 
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* Press OK and then again OK. 

Settings for CorelDRAW 

 
 

1. Go to Tools menu, and select the Options. 

2. Select Type Assist / Quick correct in the left column. 

3.  Remove the tickmarks from the following options – 
 

 
 

*   Capitalize first letter of sentences 
*   Change straight quotes to typographic quotes 
*   Correct two initial, consecutive capitals 
*  Capitalize names of days 
*   Replace text while typing 

*  Press OK. 
 

Settings for Lotus Smartsuite - Word Pro 
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1. Go to Edit menu and select the SmartCorrect option. 

 

 

 
 
 

You will come across the SmartCorrect Dialog box. 

 

 

 
 
 

3.   Remove the tick marks from the options  
 

* Change straight quotes to smart quotes 

* Correct TWoINitial CApitals 

 

Press OK. 
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Sending e-mails using Akruti 
 
Use IE and Netscape with any of e-mail account to send email in Indian Languages. 
 

INTRODUCTION 
 
Akruti software enables you to mail in all regional languages listed before. as an instance, in 
the next figure, a massage is displayed using Akruti Hindi Font. You can type the massage 
in outlook express, Netscape mesanger using Akruti Font, but for using the font kindly follow 
the following steps. 

 
 

 
 

1)   Select AkrutiDynamicPriya or AkrutiDynamicYogini font 
        from Font Selection Box. 

 
2) Select Font Size as per requirement. 

 
3) Type the massage as per the Selected Akruti Layout. 

 

After sending the massage to the destination viewer, it will be displayed on the screen in the 
form of unreadable garbage characters. So, to view the massage correctly by the recieptient 
you have to send the font file with your mail. 

 
To attach the font file to the mail, click attach button from tool bar and select the font file 
(Akruti.ttf), and send the message. 

 
The recipient has to save the file font by right clicking on the attachment by mouse and add 
the font from the control pannel by following the given route. 
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Procedure to send e-mail in Outlook Express 
 

1. Select New Mail. You will get a composition window as shown above. 

 

2. To type in any language, first run the Akruti Engine. 

 

 

 

 

3. Select the font AkrutiDynamicPriya or AkrutiDynamicYogini from the font selection 
box. as shown above. 
 

4. Set the font size, press Scroll Lock (ON), and start typing. 
 

5. To switch back to english mode, press Scroll Lock (OFF), and start typing. 
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Available Keyboard Layouts 
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Available Keyboard Layouts 
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Akruti Typefaces 

 

AkrutiOfficeAditi 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 

AkrutiOfficeAjit 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 

AkrutiOfficeAkanksha 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 
AkrutiOfficeAkshardhara 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 

AkrutiOfficeAkshay 

Mera Bharat Mahan Ÿ ½̧£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 
AkrutiOfficeChakra 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 
AkrutiOfficeChampa 

Mera Bharat Mahan Ÿ ½̧£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 

AkrutiOfficeDeepa 

Mera Bharat Mahan Ÿ ½̧£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 

AkrutiOfficeHansa 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 

AkrutiOfficeManorama 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 
 

AkrutiOfficeMogara 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 

AkrutiOfficeMouj 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 
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AkrutiOfficePriya 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 
AkrutiOfficeSulekh 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 

AkrutiOfficePriyaExpand 

Mera Bharat Mahan Ÿ ½̧£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 
AkrutiOfficeShruti 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 
AkrutiOfficeSwati 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 

AkrutiOfficeTriveni 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 
AkrutiOfficeVijay 

Mera Bharat Mahan Ÿ¸½£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 
AkrutiOfficeYogini 

Mera Bharat Mahan Ÿ ½̧£¸ ž¸¸£·¸ Ÿ¸­¸›¸ 

 

AkrutiOfficeImage1 

  a b cd e f g h i j k l m n o p q r 

st u v w x y z  

AkrutiOfficeImage2 

 a b cd e f g h i j k l m n o p q r s 

t u v  



Akruti Manual                                                                                                                                                         43 

USER REGISTRATION CARD 

 

CML Copy 
 
 

 

Akruti Vistaar 

 
Others (Pl. specify)_________________________________________________________ 

Product Code :__________________________ Date : _____________________________ 

Serial No.:_________________________________ Ref. : __________________________ 

Dealer : __________________________________________________________________ 

Name : __________________________________________________________________ 

Company :________________________________________________________________ 

Address : ________________________________________________________________ 

_________________________________________________________________________ 

_________________________________________________________________________ 

City : _____________________ State: _____________Pin :_________________________ 

Phone : ___________________________Fax :___________________________________ 

e-mail :___________________________________________________________________ 

 

 

 
 
 

Signature of Authority                                                                 Signature of Customer 
 
 

Please fill up this section and send it to CML office. 
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 Banglore Head Office :- Regd. Office : # 50, 5th Cross, 6th Main, 7th Block,  
Banashankari 3rd Stage, 4th Phase, Bangalore - 560 070.  

  Telefax: (080) 2669 3925; e-mail : bangalore@cyberscapeindia.com 
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